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OVERVIEW
 This guide walks a user though the steps to setup and configure a digital 

power device using Renesas’s PowerNavigator GUI.

 For Digital Multiphase products (ISL691xx and ISL681xx), please see the 
dedicated Digital Multiphase user guide.

 This guide assumes the user has followed the instructions on the website for 
downloading and installing PowerNavigator and is able to launch the 
program successfully.
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OVERVIEW
 The following sections are shown in this guide:
 Hardware free mode
− Selection of devices
− Power architecture setup
− Current sharing
 Connecting to hardware
− Auto scan of devices
 Device setup with Rail Inspector
− Changing device parameters
− Configuration file load and save
 Sequencing
− Time based sequencing
− Event based sequencing
 RailScope
− Adding/monitoring devices
− Logging
 Production File HEX Creation
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Offline Mode (Hardware Free Mode)
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PowerNavigator Launch Screen – Offline Mode
Connected Devices Offline Mode Project Load

Click on “Build New System” 
and then “Start”

The PowerNavigator launch screen allows you to select online (hardware connected) or 
offline modes of operation.
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PowerNavigator – System Screen Offline Mode

Part Library contains all supported 
devices. Click device groups to expand.
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PowerNavigator – System Screen Offline Mode

Hover over part with mouse to 
bring up part description and 
important specs

Expand device groups to 
see supported devices 
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PowerNavigator – System Screen Offline Mode

Right click on part to add to 
compare window.

Compare window shows device 
description, key specs and link to 
datasheet
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PowerNavigator – System Screen

2. Drop onto any node 
identified by a black square.

1. Grab any device or label and 
drag and drop into the PowerMap
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PowerNavigator – System Screen

Additional rails can be added

Layout assistant will automatically appear 
when adding parts to PowerMap

Drop parts on this 
node to cascade rails
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PowerNavigator – System Screen

Multiple parts can be added to PowerMap, representing system level view.

Individual Rail Block 
for each device

Page 11



© 2017 Renesas Electronics Corporation. All rights reserved. RENESAS CONFIDENTIAL BIG IDEAS FOR EVERY SPACE

PowerMap RailBlock Overview

Example ZL8802 RailBlock (2-PH operation):

Controller Type
Number of 
phases

Online/Offline Status

PMBus Enable/ 
Disable

PGOOD Status

Rail Name (customizable) Vout/Iout Telemetry
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PowerMap RailBlock Overview

Example ZL8802 RailBlock (2-CH operation):

Drag “Phase Dot” to 
change from 2-phase 
to 2-Channel operation

Drag and drop interface for 
configuration of a rail from 

2-phase to dual output.
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Example ISL68200 RailBlock:

PowerMap RailBlock Overview

• Controllers which do not support current share will only have one “slot”.
• In this case, we have a single phase ISL68200 controller at PMBus 

address 0x60.
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PowerNavigator – System Screen

Load Blocks represent system load and can be added to the PowerMap from the Part Library. 
Double Click to add additional inputs.

Load 
block
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Multi-Input Load Boxes Double Click Load to bring 
up Load Inspector dialog 
box

Hit “+” button to add 
additional inputs

1

2

Additional 
inputs are now 
added to load 
box

3
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PowerNavigator 5.4 – System Screen

After configuring system, all sources, rails and loads can be wired together.

Multi-input 
Load Box
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PowerNavigator 5.4 – System Screen

Source 
to Rail 
Wiring
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PowerNavigator 5.4 – System Screen

Right-click on PowerMap to bring up contextual menu. 
Select “Auto Wire All Power Lines” to auto wire PowerMap.
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PowerNavigator 5.4 – System Screen

Fully wired PowerMap with multi-input loads.
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PowerNavigator 5.4 – System Screen

To implement a current sharing rail, drag a part from the 
part library onto an open RailBlock “slot”.
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PowerMap RailBlock Overview

Example ZL8802 RailBlock (4-PH operation):

• The ZL8802 allows for 2-PH, 4-PH, 6-PH or 8-PH operation via current share.
• Each “slot” in the RailBlock represents shows how many controllers can be paralleled in a current share group.
• To create a current share group, a controller can be dragged from the part library into a “slot”, creating a current share 

rail.
• In this case, we have a 4-phase design, with two ZL8802 controllers – one at PMBus address 0x44 and another at 

0x46.

Slot 1 Slot 2 Slot 3 Slot 4

Dots represent 
number of 
phases
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PowerNavigator 5.4 – System Screen

ZL8802 4PH 
Current Share
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Monitoring View

Duty cycle and 
switching frequency

Monitoring readouts 
for Vout, Iout, Iin

Temperature monitors 
for both internal 

(controller junction) 
and external (power 

stage FETs)

PGOOD indicator
Adjustment on output 

voltage

View configuration options

Device rail name
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Readouts

Digital readout of 
output voltage

Analog sliding meter with color indicators. 
Green is within normal limits, yellow in PMBus 

warning limits, red for exceeding OVP/UVP 
settings.

Operation and fault lights

Clicking this button will open the window 
below allowing adjustment of limits
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Connecting to Hardware
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Connect to Hardware . . . 
 To connect to hardware, a USB to PMBus adapter (ZLUSBEVAL3Z, included with 

all demo kits) is required.

 STEP 1: Connect USB cable from PC to USB adapter

 STEP 2: Connect USB to PMBus adapter to demo board hardware

 STEP 3: Power demo board

 STEP 4: Launch PowerNavigator software
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Connect to Hardware . . .

USB to PMBus Adapter

ZL8800 2-Output Eval Board

ISL827x 25/33A Module

Connect 12Vin here

Multiple boards can be connected together
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PowerNavigator Launch Screen
Connected Devices Offline Mode Project Load

All discovered hardware is displayed in the “Scan Attached Devices” window. 
The PMBus scan range can be adjust – default range is 0x10 to 0x7F.

Discovered hardware 
is displayed
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PowerNavigator 5.4 – Connect to HW

PowerMap is 
automatically populated 
with attached hardware
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PowerNavigator 5.4 – Connect to HW

System load can be 
added to PowerMap. 

RailBlocks can be wired 
to input source and load. 
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PowerNavigator 5.4 – Project Save

To save a project, 
go to File -> Save

Saving a project will 
save any device 

configuration files, 
PowerMap setup, 

and PowerNavigator 
perspective settings.
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PowerNavigator – Rail Inspector
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PowerNavigator 5.4 – Rail Inspector
 Rail Inspector tool eases device configuration
 Double click on RailBlocks to bring up individual Rail Inspector for each device.
 Each device in PowerNavigator can have its own, customized Rail Inspector.

 Rail Inspector tool can be used to:
 Quickly see rail summary, including PMBus addresses, controller type, PMBus status, device options, 

fault status, etc.
 Save/Load Configuration Files
 Configure device using command tool

 Allows for future expandability
 Future releases of PowerNavigator will expand Rail Inspector features

Page 34



© 2017 Renesas Electronics Corporation. All rights reserved. RENESAS CONFIDENTIAL BIG IDEAS FOR EVERY SPACE

PowerNavigator 5.4 – Rail inspector
Double Click RailBlock to bring up 
Load Inspector window

1

Rail Inspector Window will appear2
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Example Rail Inspector – ISL68200

Rail Status

Load/Save Configuration Files

Device 
Parameters/ 

Telemetry

Device Option Summary

Enable/Disable Output 
from within Rail Inspector

Rail Inspector Navigation
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Example Rail Inspector – ISL68200

Design Requirements – Enter Vin, Vout and Iout requirements
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Example Rail Inspector – ISL68200

Component Selection – Enter FET, Inductor and Output Cap information
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Example Rail Inspector – ISL68200

Efficiency – Real time plot of efficiency with selected components and switching frequency.
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Example Rail Inspector – ISL68200

Current Sense – Automatic calculation of current sense resistor settings based on desired OC trip point.
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Example Rail Inspector – ISL68200

Pinstrap Configuration – Select pinstrap resistors to setup device default settings.
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Example Rail Inspector – ISL68200

Design Verification– Bode and Output Impedance plots of design.
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Example Rail Inspector – ISL68200

Schematic Generation – Final schematic, with customized components, generated automatically.
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Example Rail Inspector – ISL68200

Phase Scope – Real time plotting of all telemetry parameters.
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Example Rail Inspector – ISL68200

Select Command Tool in 
Rail Inspector

Command Line to select 
PMBus command

Send/Read commands 
to target device

Add/Remove 
command lines in 

command tool
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Example Rail Inspector – ISL68200

Clicking “Search” allows 
the user to quickly find 
any PMBus command 
the device supports
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Sequencing
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PowerNavigator – Sequencing
 All Renesas Digital Power Controllers and modules with a DDC bus support 

autonomous sequencing between rails.

 Sequencing is configured using the PowerNavigator sequencing tool.

Once configured, all sequencing events are handled automatically using Renesas's
proprietary DDC bus.
 Controllers and/or modules will automatically communicate via DDC bus, synchronizing sequencing 

events.
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PowerNavigator – System Screen
Sequencing Tab

The sequencing tab allows for power up and power down sequencing of devices in the PowerMap.
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PowerNavigator GUI – Sequencing

Sequencing Tab in GUI
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PowerNavigator – Sequencing
 Event based sequencing waits for the device PGOOD to transition high (the event) 

before sequential rails start-up
 Sequence order is set by Prequel/Sequel using the SEQUENCE PMBus command
 TON_DELAY is used to set the time delay between sequenced rails 

 Timed based sequencing uses a timer from a global enable to sequence rails at 
start-up.
 TON_DELAY sets the sequence order on the way up. TOFF_DELAY sets the order on the way down.
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Event Based Sequence Example

Event Based sequencing selected

5ms delay programmed between rails
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Event Based Sequence Example

CH1: 0.9V

5ms

CH2: 1.2V

CH3: 1.5V

CH4: 3.3V
TON_DELAY sets 

the sequencing 
delay between rails

5ms 5ms
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Time Based Sequence Example

Sequence order is set by Ton_Delay
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Time Based Sequence Example

CH1: 0.9V

20ms

CH2: 1.2V

CH3: 1.5V

CH4: 3.3V

20ms 20ms

30ms
50ms

70ms

TON_DELAY sets the 
sequencing delay from the 

common enable signal
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Railscope
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PowerNavigator 5.4 – RailScope
 New RailScope allows the user to plot telemetry parameters from up to 4 devices.
 Similar to a Low Bandwidth Oscilloscope integrated into PowerNavigator.
 Allows user to plot multiple telemetry values at a time.

 Logging capability is also built-in.
 All telemetry values can be logged to a .csv file for later viewing.
 Status registers are also logged.

 Adjustable update rate allows users to control how much data they collect.
 Data can be updated as fast as 1ms and as slow as 1000ms.
 Displayed points can be as few as 50 to as many as 500.
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PowerNavigator – RailScope

Example Vout Plot

View up to 4 Rails at one 
time

Select up to 4 
telemetry 

parameters per 
device

RailScope 
controls

Enable/disable 
logging

Adjust Plot 
size

Real time telemetry 
showing device ramp-up!
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RailScope: Initial Setup
If RailScope is not visible, go to View->RailScope1

Double Click on the “Slots” 
to add rails to RailScope2

In “Load Rail” window, 
select rail to add to each 

slot.
3

Click “Ok” 
when done4
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RailScope: 2 Telemetry Parameters

Vin and 
Vout 

Telemetry 
Parameters 

selected

Chart Area automatically 
splits into two graphs
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RailScope: 4 Telemetry Parameters

Vin, Vout, 
Iout and 
Temp 

Telemetry 
Parameters 

selected

Chart Area automatically 
splits into four graphs
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RailScope: Example Zoom-in

Click and drag to 
highlight zoom area in 
chart. Double click to 

return to previous Zoom 
level.
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RailScope: Example X & Y-axis Scale Options

Click Toolbox icon to 
bring up y-axis limits box

When “Auto Ranging” 
check box is clicked, 
PowerNavigator will 
auto-set y-axis scale

Unchecking “Auto 
Ranging” box allows user 

to set upper and lower 
bounds

X-axis scale is set by 
update rate and display 

point user settings
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RailScope: Logging Feature
Once enabled, logging feature will automatically log all selected telemetry 

parameters and the STATUS_WORD register for each device.

 All data is saved to a .csv file, which can be opened in Excel for later data 
analysis.
 Once the .csv file size exceeds 50MB, a new file will automatically be created.
 There is no limit on how long logging can run for.

 The log file name and path can be changed by the end user.

Page 64



© 2017 Renesas Electronics Corporation. All rights reserved. RENESAS CONFIDENTIAL BIG IDEAS FOR EVERY SPACE

RailScope: Example Log File

Telemetry parameters for 
“VCCIO” rail

Telemetry parameters for 
“AUX” rail

Rail name can be 
set by user (taken 
from PowerMap)

Each telemetry 
entry is time 

stamped
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HEX File Creation
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Configuration File Overview
 Renesas Digital Power controllers use configuration files to program important 

device parameters.
 Configuration files are basically a list of PMBus commands defining device operation. i.e. 

Vout_Command = 1.0V, Iout_Cal_Gain = 0.5mV/A, etc.

 Device configuration only needs to be done one time – programmed parameters 
are stored inside non-volatile memory for future use. NVM supports multiple writes 
and is re-programmable.

 Several Options are available for programming devices in a production 
environment.
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Programming Devices in Manufacturing Environment

Option 1: Program controllers pre-board assembly
 Devices are programmed on a high speed production programmer before being 

assembled on a board.
 Can use a supported 3rd party programming house OR offline programmer at sub-

contractor.

Option 2: Program controllers after board assembly
 Devices are programmed on PCB post board assembly
 Can be done at ICT (using a bed of nails approach or onboard microcontroller) OR 

using Renesas dongle and Production Configuration Tool (PCT).
 Requires board to be powered up with all controllers DISABLED until they are fully 

programmed.
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Typical Flow – Pre-Programmed Devices
 Controllers are programmed prior to PCB 

manufacture. 

 Hex files are created using PowerNavigator 
software (File->Export Production Hex).

 Programming is done either with a 3rd party or 
using offline programmer at subcon.

 Typical programming time: 4-7 seconds per device.

 Individual part numbers are assigned to each 
device after programming to make sure boards are 
assembled correctly.

Finalize Config Files

Program Controllers

Pre-programmed controllers shipped to CM

Assemble/Test Boards

Convert config files to 
Hex format

Send Hex files to 3rd Party 
(if using) or Subcon

Finished Boards
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Typical Flow – Programming Parts on Board
 Controllers are programmed after board assembly.

 Typical Programming time: 5-10s per device.

 Simplified inventory and configuration file 
management.

 Controllers must be powered to program, but output 
must remain disabled until part is fully programmed.

 Special attention to sequencing must be made 
when using self-enabled parts.

Finalize Config Files

Program Controllers 
using dongle/PCT

Assemble Boards

Power Board for Prog.

Prog. at ICT?

Power Board for Prog.

Prog. Using ICT test 
fixture/ bed of nails

Final Test

Finished Boards

YESNO
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HEX File Creation – Step 1, Project Save

Step 1: To create a 
production HEX file, 

first save your project

NOTE: Before saving a project, 
the HW enable pin on all 
controllers must be held low.

NOTE: All Project files are stored in the 
directory: 
C:\Users\USERNAME\Documents\Intersil\
PowerNavigator\Projects
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HEX File Creation – Step 2, Export HEX Files

Step 2: Go to File -> 
Export Production Hex

NOTE: All Production HEX files are stored in the saved project 
folder, located in the directory: 
C:\Users\USERNAME\Documents\Intersil\PowerNavigator\Projects

Click “Export”
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Example HEX File Creation

Devices from 
PowerMap 

automatically populated

Programming address 
is address used on 

High Speed 
programmer socket

HEX file name 
can be set by 

user
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Example Configuration File
Header information with device type, 
FW version, creation date, etc.

Programmed device parameters

This sequence of commands is 
used to clear contents of NVM.
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Example HEX File

Configuration file translated into 
machine readable HEX format.
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